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INTRO TO SAXOTECH ONLINE EDITUI

SAXOTECH ONLINE EDIT UI gives you an alternative way to publish to your website 
outside of the MediaWare Center. Since the two programs share a common database, all 
content that is created in the MediaWare Center will be available in Saxotech Online EditUI, 
and all content that is created in Saxotech Online EditUI will be available in MediaWare 
Center.

In general, if your site is using the MediaWare Center to create content and communicate 
with the Design House, you should also use the MediaWare Center to manage your web 
content. 

If your site is not using the MediaWare Center, you will use Saxotech Online EditUI as the 
primary way of producing and managing your Web content. 
 
This chapter will cover the basics of Saxotech Online EditUI, including:  
	  
	 Logging in 

	 Creating a story

	 Creating a photo gallery

 

ONLINE TERMS TO KNOW

Story: The content type where  you will write your articles. A story in Saxotech Online 
EditUI appears as an article in the MediaWare Center. They are the same elements, with 
different names. 

Categories: Categories correspond with the sections that appear in the top navigation of 
your website.

Taxonomies: Taxonomies are how you control where you content will be published online.
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LOGGING IN TO SAXOTECH ONLINE EDITUI

ACCESS SAXOTECH ONLINE EDIT UI 
To access your Saxotech online EditUI interface, go to the homepage of your website and 
type  
"/edit" after the URL. The address will look like this: 

	 >> www.yourwebsitehere.com/edit

ENTER YOUR USERNAME AND PASSWORD 
	 >> If you don't already have a username and password for Saxotech Online EditUI, 
or if you have issues with your password or logging into Saxotech Online, please contact 
GateHouse Media Support at https://gatehouse.zendesk.com/

Menu >>

Recent 
stories >>

 
 
YOUR SAXOTECH ONLINE HOME SCREEN

The Saxotech online home screen is the first screen to appear after you log in. From this 
screen, you can create new stories and galleries and view a list of recent stories. The menu 
items (in the black bar at the top) are available on every page.

<< Create 
new story 
 
 

<< Create 
new gallery
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WORKING WITH STORIES 

Stories are the main way you will create content in Saxotech Online. If you are using the 
MediaWare Center, the stories you create in Saxotech Online will appear as articles.

 
CREATE A NEW STORY 
There are two ways to create a new story. You can press the New Story icon on the home 
screen, or choose New Story from the editorial menu. 
	 >> To create a new story from the home screen, press the New Story icon. 
	 >> To create a new story from the menu, find the EDITORIAL tab in the black menu bar 
at the top of the page. Select  EDITORIAL > New story. 

Once you have created your new story, the next screen you will see is the Edit Story 
Screen. The Edit Story Screen has six tabs: Properties, Edit, Pictures, Keywords, 
Connections/Statistics and Preview.

	

	

You will need to fill out the following three tabs, which are detailed on the following pages:

	 >> PROPERTIES TAB  Control the publication time and date of the story. 
	 >> EDIT TAB  Write the story and add photos and fact boxes. 
	 >> KEYWORDS TAB Designate where the story will be published. 

After you have completed those three tabs, press the Save or Save & Close button at the 
top right of the page. This will save the changes you have made on your story, and publish it 
to your website.
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THE PROPERTIES TAB 

SET STORY PROPERTIES 
The Properties tab is where you will control the publication details of the story. To find these 
settings, open a story and click on the tab that says Properties (upper left side). 
 
In this section, add the basic publication settings for your story. You will need to make 
choices from the fields listed below. Only Published, Pub. Date and Category are required: 

Published: Check this box when you want the story to be published. The story will publish 
once you press Save (top right corner). Uncheck this box if you want to remove (unpublish) 
a story, or if you are writing a draft.

Pub. Date:   This field contains the publication date for the story. The system will suggest 
today's date. 

Retain Date: When you edit a story, the date and time is changed to reflect the latest saved 
change. By marking this checkbox, the original story date and time is kept when you make 
changes to the story.

Use publish control: Allows you to control when a story will be published in the future. 
Choose the date and time you would like the story to go up in the From dropdown menu. 

Category:  In this drop-down menu, you can select which category you want the story 
to be assigned to. Choose the most appropriate category: News, Sports, Business, 
Entertainment & Life, Obituaries, Opinion, Photo Gallery, Video. Choosing a category 
allows you to find your content more easily later. In addition, the category you choose 
becomes part of your story's URL, and enhances the search engine optimization for that 
story.

Location:  Check to enable a dateline, which is displayed in front of the summary. It is  
	 used to tell where the news item took place. NOTE: If the Location box is checked, the 
system will insert a dateline into your story, which is your location. If you already have a 
dateline on your story, and this box is left checked, you will have a double dateline on your 
story. Uncheck this box if you already have a dateline on your story, or if you want your 
dateline to be different from your location.

REQUIRED 
FIELDS
* *

*

*
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THE PROPERTIES TAB (CONT'D) 

OPTIONAL FIELDS IN THE PROPERTIES TAB 
 
The following fields are not needed for basic story publication to your website

 
	 Forum: This controls commenting on the story. Choose On or Off to enable or disable 
commenting on a story.
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THE EDIT TAB 

WRITE AND EDIT YOUR STORY  
 
The Edit tab is used for writing and editing the story content. When you click the edit tab, 
the following screen appears. You will need to fill out the following fields: 

Title: Enter your headline here.

Location: Enter your dateline here, if it is different from your default dateline.

Summary: In addition to the title, the summary is visible if your story is published to the 
Carousel on your homepage and on the section fronts. Write a short summary of your story 
here. If you do not write a summary, part of the first paragraph of the body of your story will 
be shown on the section front and front page.

Byline: Enter the name of the author.

Smart Byline: Mark this checkbox to use Smart Bylines instead of entering a free text 
byline in the Byline field. Go to the Smart Byline section of this handbook.

Story body: Enter the body of your story here. You can enter all of your text into one field, 
separating the paragraphs by pressing Enter. 

REQUIRED 
FIELDS
*

*

*
*

*
*
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ABOUT STORY FORMATTING 

You can format the text in your story by using the toolbar available at the top of each story 
body paragraph.

FORMAT YOUR TEXT 
To add Bold, Italic and Underline to your text, highlight the area you want to change and 
press the appropriate button from the toolbar.

REMOVE FORMATTING 
To paste a story from a word processing program (like Microsoft Word), use the Paste As 
Plain Text button. If you need to erase formatting after you have pasted, use the eraser.

ADD A HYPERLINK  
To add a link to an outside source, highlight the text you want to link to and press the 
Insert/Edit Link button. To remove a link, click the Unlink button.
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ADDING PHOTOS 

ADD PHOTOS TO YOUR STORY  
The main photo of your story is what appears in the carousel. It is also the thumbnail that 
appears next to your article when it is published to a section, and it appears at the top of 
your story when it is published.

A story can contain only one main photo. The maximum number of photos is nine extra 
photos plus the main photo. If you need more photos, use the Pictures tab or create a 
Photo Gallery to attach to a story. 

ADD A MAIN PHOTO  
To add a main photo to your story, click the orange triangle next to the words Main Photo.  
	 >> To upload a photo from your computer, press the Browse button and select the 
	 appropriate photo. Then, fill out the following fields:

NOTE: Use IPTC: Check this box if cutline 
information is embedded on the photo.

Then fill out the rest of the fields:

Title: Enter a caption heading for the photo.

Caption: Enter the caption for the photo 
here if no caption information comes with the 
photo.

Photo credit: Enter the name of the 
photographer or source. 
 
ALT text: This is what appears when a visitor 
to your website hovers over the photo. Use 
SEO keywords. 
 
Filename (SEO): Enter SEO keywords in this 
field. 

Browse: Search your computer for a photo 
to upload.

Preview: This field shows a preview of the photo.

Save: Click to confirm your selection and save your changes. The Edit photo window will 
close.

Cancel: Click to close the window without saving your changes. 

Delete: Click to delete the photo. 

Search: Click to open the search function to reuse a photo already in the system.  Enter 
a search term and filter by date or select From and To dates to limit your search. Click 
Search to start your search. Click the Use button above the photo you want to use. 
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ADDING PHOTOS (CONT'D) 

ADD EXTRA PICTURES TO YOUR STORY  
In addition to the main image, each story in Saxotech can have several additional images, 
known as Extra Pictures in Saxotech. 

	 >> To add extra pictures to a story, click on the  Pictures tab.

	 >> To upload more than one photo at a time, press Batch Image Upload. Instructions 
	 for the batch uploader are located in the Photo Galleries section of this handbook. 

	 >> To upload one photo at a time, press the New Image button at the top right of 
	 the page. When the pop-up window appears, press the Browse button to choose the 
	 appropriate image from your computer. Then, fill out the following fields: Title, 
Caption, Photo credit, ALT Text, Filename (SEO). Details about these fields are 
explained on the previous page. 

	 >> When the image is uploaded and all the fields have been completed, press Save. 

To make an extra picture a main picture (and vice versa), change the photo type using the 
dropdown menus underneath the Type column. 

If you would like to indicate the order of your extra pictures, you can do so by switching the 
numbers underneath the Sort (Extra Pictures) column. 

	 >> When you are finished with all changes on this page, press Save. 

MYCAPTURE AND PHOTOS
To add MyCapture to a photo

>> Find your MyCapture credit. The credit is the same one you used for MyCapture in 
Zope. If you don't know your newspaper's credit, please submit a Zendesk ticket (https://
gatehouse.zendesk.com)

>> Enter your MyCapture credit in the credit field of a photo you wish to sell. The credit 
can be entered be at any point in the credit field, but must be entered in that field when the 
photo is uploaded into Saxotech. 

>> Publish your photo. The correct credit will trigger the MyCapture shopping cart icon on a 
photo when it is published to a photo gallery or an article.
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RELATED CONTENT
 

To add stories and links to an item as related content, you will need to go to the 
Connections/Statistics tab. 
 
ADD RELATED CONTENT TO YOUR STORY  
	 >> To add a link to an item that is already posted to your website, open the story and  
	 choose the Connections/Statistics tab. Look under the Internal links header. 
	 >> Press the change button. This will bring up a searchable content window.  
	 >> Use the dropdown menus to find your content. Press Search. 
	 >> To find a video, choose CCE from the Type dropdown menu. 
	 >> Locate the item(s) you would like to add as related content. Check the box in 
	 the Connect column next to the item(s). 
	 >> When the correct boxes are checked, press Apply Connections. Press Close. 

 
ADD EXTERNAL LINKS TO YOUR STORY  
To add a new External Link, look underneath the External links area, which is the 
third item listed on the Connections/Statistics tab.

	 >> Press Change. 
	 >> In the pop-up window, press New Link. On the Edit Link page, add a Title for the 
link. 
	 >> Add the URL for the external link you would like to add in the Link area. Make sure to 
	 add the entire link, including the http:// (Ex: https://www.google.com/) 
	 >> Press Save. 
	 >> On the next screen that appears, make sure the new link is selected, and press 
	 Apply, then Close.

If a link has already been added to the system, you can enter a the name of the link in the 
Search box and press Search.
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THE KEYWORDS TAB 

The keywords tab is where you will control where your story will be published on your 
website, and what taxonomy words are associated with it. 

ADD TAXONOMY TO YOUR STORY  
Taxonomy is how you will control where your story will be published on your website. You 
can think of taxonomy words as topic tags that organize your content.  
	  
	 To choose a taxonomy for a story ...

	 >> Click on the button that says Choose from list. 
	 >> A list of taxonomies will appear. Underneath the taxonomies button, you will 
	 need to choose from three menus: Placement, Publications and Topic.  
	 >> Press the Plus button next to each area to choose your taxonomies.  
		   
Placement: These are the Placement taxonomies you need to choose from:

	 Carousel

	 News Now (called Latest News on your website)

	 Photo Galleries 

	 Top Stories

 Publications: Check the website you would like to publish to.

 Topic: Under this category, choose the most specific taxonomy topic you can. For   
instance, if you have a high school football story, make sure to check HighSchool Foot 
instead of Sports. Sports  and High School Sports will automatically be checked since they 
are higher taxonomies.

>> Press OK. 
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THE KEYWORDS TAB 

NOTE: Once you are familiar with all the taxonomies available to you, you can use the 
Search function to quickly add taxonomies to your story.

USING THE SEARCH FUNCTION

 >>Click on the Search tab. A pop-up box will appear.

>> Type in  the most specfic word from the available taxonomies that could apply to 
your story in the search box. For example, Saxotech uses the word "homicide" instead of 
"murder," so you would need to use "homicide" to search for the correct topic taxonomy for 
a story about a murder.

>> Click Search.

>> Click on the appropriate taxonomy sequence.

>> Click Add. Your choice will appear in your Selected taxonomy box. 

>> Click Save in the upper right corner.
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PHOTO GALLERIES: SAXOTECH EDITUI 
 

CREATE A PHOTO GALLERY  
From the Home screen in Saxotech online, press the Galleries button. 
This will bring up a screen that lists all of your current galleries.  
	 >> To create a new gallery, click on the New button on the upper  
	 right side of the page. 
	 >> To search for galleries that have already been created, use the  
	 dropdown menus on the search page. 

You can also create a new gallery by choosing New Gallery from underneath the Editorial 
dropdown menu.

Once you create a new gallery, you will see a page that controlls your publication settings. 
This page acts much the same as the publications page for a story.

	 >> To publish the gallery, check the Published box and press Save. 
	 >> To unpublish the gallery, uncheck the Published box and press Save. 
	 >> Choose a Date, Title, Category (Photo Gallery) and Description for your gallery. 
	 >> Choose Taxonomy for your gallery. Press Choose from list, then check the 
	 appropriate Placement (Photo Gallery) and Publications.

When you have filled out all the appropriate boxes, press Continue.

After you press Continue, you will be directed to the Gallery Images page. If you already 
have images in your gallery, they will appear in the list on the page. From this screen, you 
can add images, delete images, batch upload images and edit titles, captions and order of 
images in your gallery.
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PHOTO GALLERIES: BATCH IMAGE UPLOAD 
 

ADD IMAGES TO YOUR GALLERY  
To add images to your gallery, press Batch Image Upload on the upper right side of the  
Gallery Images page (Reach this page after pressing Continue).

On this screen, you can drag and drop the images you would like to add to your gallery into 
the space provided, or choose from the files on your computer. Once the correct photos are 
chosen and displayed, press the Green Arrow to upload the images into the system.

Once your photos are uploaded, you will need to add caption information. If your captions 
were added prior to batch upload, then they will transfer over into the system.

To add or edit image title or photo credit 
	 >> Press the Edit button next to the photo you would like to edit. The Edit button is  . 	
	 a small arrow to the left of the image you would like to edit. (See image at left). 
	 >> On the edit page, add Title, Caption and Byline information. You can manage 
	 the order of the images in the gallery using the Photo no. field.  
	 >> When finished with edits, press Save. 

 
To publish the gallery, navigate back to the Gallery Propeties page (button on upper right 
side). Make sure the Publish box is checked, and press Save.
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PHOTO GALLERIES:  MULTI-PHOTO UPLOAD PAGE

	 LOG IN TO THE PHOTO UPLOADER 
	 To upload multiple photos at once, access the photo upload page outside of  
	 Saxotech. You can log in at the following address: 
	  
			   Site: http://photos.gatehousemedia.com/ 
			   Username: Your state name. (In most cases) 
			   Password: Same as username

NOTE: Please submit a Zendesk ticket if your state name doesn't work as your username 
and password. Make sure you include your newspaper name and state. Your username and 
password for uploading photos is the same as your username and password for uploading 
videos.

>> Click on the button that says Photos

UPLOAD YOUR PHOTOS 
>> Fill out the fields for Title and Description, These will be visible on your website.

>> Click on Choose files next to Upload Photos.

>> To upload more than one photo at a time, hold the Shift key when you select, to select 

an entire group. Hold down the Command key (Mac) or Control key (PC) to select multiple 
photos that are not grouped together. 
>> Fill out the fields for Common image details. When you check the Use for all box, this 
information will appear on all of the photos uploaded for this particular gallery. 

>> If you want to change some of the common information for some photos, you can edit 
each individually in the text fields next to them after you have uploaded them by clicking on 
the Use for individual box on the far right and typing in new information.

 
>> Click on Create gallery at the bottom of the page.

Once you click on Create gallery, you will see a "Processing" notice. When your gallery is 
completed, you will see a pop up box with a link to access your gallery in Saxotech EdiUI. 
Click on that link. You will need to sign in to Saxotech EditUI if you are not already signed in.

*
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PHOTO GALLERIES: MULTI-PHOTO UPLOAD PAGE
	 

Once you click on Create gallery, you will see a "Processing" notice. When your gallery is 
completed, you will see a pop up box with a link to access your gallery in Saxotech EdiUI. 
Click on that link. You will need to sign in to Saxotech EditUI if you are not already signed in.

PUBLISHING YOUR GALLERY 
>> Click on Galleries from your Saxotech EditUI homepage, either in the icons on the right 
side of the page or from the Editorial drop down menu at the top of the page. 
>>Click on the curved arrow icon on the left side of the page to access your gallery.

>> Check that all of the information for the gallery is accurate.

>> To change the order of the photos in the gallery, click on a photo and change the Photo 
no.  in the pop-up box.

>> To publish your gallery, click on the Gallery properties tab on the upper right of the 
page.

>> Choose a Date, Title, Category (Photo Gallery) and Description for your gallery. 
>> Choose Taxonomy for your gallery. Press Choose from list, then check the 
	 appropriate Placement (Photo Gallery) and Publications.

>> Click on the box next to Published on the Gallery properties page.

>> Click Save on the upper right of the page.
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THE STORIES PAGE 

	

STORIES PAGE OVERVIEW 
 
To find a story to edit or view, you will first need to locate it on the Stories page. On this 
page, you can tell when a story was published, what category it was published to and how 
many images and comments a story has. You can also open a story up for editing, delete 
and preview stories. 

ACCESS THE STORIES PAGE 
 
	 >> From the Home screen in Saxotech Online (press the  
	 Home button in the top left corner), choose the stories  
	 button (right).

	 >> You can also access the stories page  
	 by selecting Editorial from the black menu at the top of the 
	 page. Underneath that menu, select Stories. 
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THE STORIES PAGE (CONT'D) 

LEARN THE DROPDOWN MENUS  
To find content on the stories page, you will first need to learn how to use the dropdown 
menus. Within these menus, you can sort within the following fields: Status, Intervals, 
Category and Story text.

	 Status: This button searches for stories based on their publication status. Choose from 
	 Published, Pending, Unpublished, Restricted, Archived, Backed up and Locked. 
 
	 Predefined intervals/date: In the next tab, you can switch between searching by 
	 predefined intervals or a specific date by clicking the blue button with a little "x" on it 
	 next to the menu.  
	  
	 Predefined intervals searches for stories based on when they were published. Choose 
	 from  No Date, Tomorrow, Today, Yesterday, Last week, Last 2 weeks, Last Month, etc. 
	 Date allows you to search by a specific date. 
 
	 Category: Search by the category the story was published under: All, UNKNOWN, 
	 Articles, Business, Entertainment & Life, News, Obituaries, etc. 
 
	 Search box: Use the search box at the end of the row to search a story headline, text, 
or keywords for a specific word. To search the system, first you will choose which area you 
would like to search (story text, title, keywords, etc.) from the dropdown menu. Then, 
type your search term in the white box.

 
>> When you have selected the appropriate fields, select Filter.
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THE STORIES PAGE, CON'T 

CHECK TAXONOMIES, PUBLICATION STATUS AND MORE 
You can use the stories page to easily check which taxonomies a story has been published 
to, the publication status, the number of photos attached, force a recache of the story when 
you have updated it and access it for editing.  Hover your cusor over each of the icons on 
the left of the story page to see what they do.

You can also easily check the publication status of a story and publish or unpublish it. The 
publication status is shown in the Status column to the right of the story. If the status is 
Unpublished, click on the status to publish it. If the status is Published, and you want to 
unpublish it, click on the status.
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	 CREATING A POLL 
	 >> Choose Q&A from the menu in the black bar at the top of the page. 
	 >> Choose New Item. This will bring up the page for a new poll.  
	 >> On the new poll page, fill out the following fields: 
		  - Under Category,  01 Homepage Poll should be the default selection. 
		  - Under Profile, select POLL followed by your site name 
		  - Enter a Title. This will not appear on your site, but will appear in Saxo search 
		  - Enter an Active from date. If you want your poll to go up immediately, leave this 
alone. Enter a date if you want to publish a poll on a future date. Time is optional. 
		  - Fill in the Active to field. This will ensure this poll will come down when you want a 
new poll to go up.

	

>> Press Continue. This will allow you to add questions and answers to your poll.

>>On the right side of the page, press Add Question. 
	 >> Enter your poll question in the Question field (This will appear on your site). 
	 >> Check the box that says Required. 
	 >> Next to Type, select Radio buttons. 
	 >> Next to Alternatives, write the answers to your question. Put each answer in  
	 quotes, and separate them by commas. 

		  EX: If the question is "Who is your favorite Beatle?",  your answers should be written 
		  like this: "John", "Paul", "George", "Ringo"

>> Press Save at the bottom of the questions box. 
>> Press Save again in the upper right side of the page.

NOTE: If your poll does not appear, make sure it has an Active to date. If it does, and is still 
not appearing, please submit a ticket to our tech support desk: gatehouse.zendesk.com

 
To add your poll as related content to a story, go to Q&A > Items. Click on Filter. Find the ID 
number of your poll on the far right. Type that number into the Saxoarticlepoll box at the 
bottom of the Edit story page of the story you wish to add the poll to. Click Save at the top 
right of the page.

 

*
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ADDING VIDEO 

	 LOG IN TO THE VIDEO UPLOADER 
	 To upload video on your new site, you will need to access the video player outside of  
	 Saxotech. You can log in at the following address: 
	  
			   Site: http://videos.gatehousemedia.com/ 
			   Username: Your state name. (In most cases.) 
			   Password: Same as username

NOTE: Please submit a Zendesk ticket if your state name doesn't work as your username 
and password. Make sure you include your newspaper name and state. Your username and 
password for uploading videos is the same as your username and password for uploading 
photos.

>> Click on the button that says Video after you log in.

UPLOAD A VIDEO 
>> Press Browse to choose a video from your local computer. 

			   Videos must be under 1.7 G and in one of the following formats: .avi, .avs,  
			.   dv, .dv25, .dv50, .dv100, .f4v, .h261, .h263, .h264, .m4v, .mjpeg, .mov, .mp4, 
			.   m4a, mpeg, .mpegts, .mpegtsraw, .mpegvideo, .rawvideo, .rm, .swf, .u8, 
			.   wc3movie  
		   
>> Enter a video title into the Title field.  
>> Enter a video description into the Description field. 
>> Check all publications that you wish this video be posted to. 
>> Click the Upload button. Your video will appear on your video page shortly.

*
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ADD A FACT BOX 

     ADD A FACT BOX TO YOUR STORY 
      >> Open the story you would like to add the fact box to. 
        >> Navigate to the EDIT tab. 
        >> On the right side of the page, press the dropdown that 
        says Main Fact Box. 
        >> In the TITLE field, write the title for your fact box. 
        >> In the BODY field, write the body for your fact box. 
        >> Under alignment, press LEFT. 
        >> Press SAVE. 

        NOTE: No image will display with the fact box, so do not add 
        images here. 

VII
SAXOTECH ONLINE  

ADD A VIDEO AS RELATED CONTENT 
 

Before you add a video as related content, you will need to upload the video to your website. 
After you have done that, follow these instructions. 
 
	 FIND THE VIDEO ON THE CONNECTIONS/STATISTICS TAB 
	 >> Open the story you would like to add the video to. 
	 >> Navigate to the Connections/Statistics tab. 
	 >> Press CHANGE under Internal Links. 
	 >> When the window pops up, choose VIDEO underneath the Category dropdown. 
	 >> Choose your search interval from the dropdown. 

	  
	 >> Under TYPE, choose CCE. 
	 >> If you have a search term you would like to use, add it to the TEXT box. 
	 >> Press FILTER. 
	 >> Place a CHECK next to the video you would like to add. 
	 >> Press APPLY CONNECTIONS. 
	 >> Press CLOSE. 
	 >> Close the box. When you are back to the main story page, press SAVE.
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ADD A MAP TO YOUR STORY 
 

	 ADD LOCATIONS ON A MAP AND LINK IT TO A STORY 
	 >> Open the story you would like to add the map to. 
	 >> Click on the CONNECTIONS/STATISTICS tab. 
	 >> Under GEOGRAPHICAL DATA, click CHANGE. 
	 >> Under NAME, write the name of the location. This will be the name you will search for 
	 should you need to map this location in the future. 
	 >> Under LOCATION, type in the postal address of the location you would like to add.  
	 >> Click SHOW ON MAP. 
	 >> Saxotech will automatically populate latitude and longitude values.  
	 >> Press SAVE. 
	 >> To add another location, repeat the steps above. If you are searching to add an 
	 additional location you have already added to the system, use the search fields in the 
	 popup window. Check all the locations that apply, and save and close. 
	 >> Press CLOSE. You will see your locations listed under the Geographical Data area of 
	 the page. 
	 >> To make your changes live on the site, make sure to press the story save button at 
	 the top of the page. Your locations will appear as red markers on that map.

 
If you have already used a location, the system will remember it. So, if you want to record 
all of the traffic accidents that have occurred over the course of a month, for instance, you 
could search for those locations you have named "traffic accident" to add them to your 
map.
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ADD A RELATED FILE 

     ADD A RELATED FILE TO YOUR STORY 
      >>  You can now add related files to a story for a reader to download. 
	 >> Open your story and press the CONNECTIONS AND STATISTICS tab. 
	 >> Under ASSETS, click CHANGE. 
	 >> When the new window pops up, click UPLOAD NEW. 
	 >> If you'd like to add an EXTERNAL LINK to a file, click YES. 
	 >> If you'd like to upload a file from your computer, click NO. 
	 >> Choose your FILE. 
	 >> Add a TITLE in the title field. 
	 >> Click SAVE. 
	 >> A new dropdown will appear. Select the media type as RELATED FILES. 
	 >> Supported file types: PDF, .DOC, .XLS, .MP3, .JPG, .PPT, .ZIP, .RAR, etc. 
	 >> Press SAVE. 
	 >> Press CLOSE. 
	 >> Save and publish your story. A .pdf will open in a new window. Any other file type will 
	 download for the reader. 

     
	 ADD AN AUDIO FILE TO YOUR STORY 
	 >> Follow the instrucitons above.  
	 >> If your file type is .mp3, an audio player will display on the page. 

 

VII
SAXOTECH ONLINE



GATEHOUSE MEDIA SAXOTECH HANDBOOK

26

VII
SAXOTECH ONLINE

 

RANKING STORIES IN THE CAROUSEL 

YOU CAN SET OR CHANGE THE ORDER OF STORIES IN THE CAROUSEL 
Once you have published a story to the Carousel placement taxonomy, you can control the 
order it appears in the Carousel on your homepage.

>> Go to the Editorial dropdown menu in the black navigation bar at the top of the 
homepage in Saxotech EditUI.

>> Click on Carousel at the bottom of the dropdown menu.

This will take you to a stories list page,  Choose your publication from the Publication 
dropdown menu. Choose Section >> Carousel from the Placement dropdown menu. Click 
Filter Items. You will see a list of the last 50 stories published to the carousel on the left 
(Filtered Content).

Click on Update carousel on the right and you will see the 10 most recently posted 
carousel stories on the right  (Carousel Content). 

You will see the current order of stories in your carousel in the Pos ("Position") column in 
the Carousel Content list.

To rank a story:

>> Put a new number in the box in the Prio. ("Priority") column.

>> Click on Update Carousel in the upper right of the page.

NOTE: Ranking content in the carousel keeps it there. If you rank all of your stories in your 
carousel, no new content will flow into your carousel. To unrank content, set the Rank to 0. 
Click on Update Carousel.*
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PUBLISHING A BREAKING NEWS NEWSLETTER 

YOU CAN SEND OUT A NEWSLETTER FOR BREAKING NEWS 
When you have a breaking news story, you can create and send a newsletter to your 
subscribers.

>> In the Saxotech EditUI, publish an article that you want to go in the newsletter to the 
Breaking Newsletter taxonomy.

>> From the Editorial dropdown menu, select Newsletters.

>> Select New Item in the upper right corner of the page.

>> From the Template dropdown menu on the Edit newsletter page, select Breaking - 
your publication - yourdomain.com.
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PUBLISHING A BREAKING NEWS NEWSLETTER 

>> In the Newsletter title field, enter the title that will appear as the subject of the 
email. NOTE: The system will automatically add "Breaking news" at the beginning of your 
newsletter title.

>> Scroll down to the bottom of the page, to Receiver Selection.

>> Click on [TARGET] Breaking - your publication - yourdomain.com

>> Click on the >> button between boxes.

>> At the very bottom of the page, choose Send now! from the or choose drop down 
menu.

>> Hit Save at the top right of the page. Your breaking news newsletter will be sent to your 
daily newsletter subscribers.
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CREATING A BREAKING NEWS 'BIG PACKAGE' 

When you have a big breaking news situation, you can publish your stories, photos and 
videos in a "big package" takeover of the top of your homepage.

>> On the Keywords tab of your story, click on Choose from list in the Taxonomy section.

>> In the Placement taxonomy list, choose Homepage - Breaking News/Big Package. 
Click OK. Click Save at the top right of the page.

Your story, along with all related photos, photo galleries, videos and stories will be published 
together at the top of your homepage. The Carousel will appear as a horizontal scroll 
beneath the breaking news package.
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SMART BYLINES 

     ADD A STAFF PROFILE 
      >>  Before you add a smart byline, you will need to create a staff profile. 
	 >> In the EditUI, look in the black bar at the top for the dropdown called Admin. 
	 >> Under Admin, choose Staff. 
	 >> When the Staff directory comes up, press New Item to add a new person. 
	 >> Type a Staff Member ID. This must be the same as the EditUI login username. 
	 >> Type the staff member's First Name and Surname in the appropriate fields. 
	 >> Under Office, type what you would like to appear in the Byline Attribution field. 
	 When it displays on the site, it will be underneath the author's name. Ex: Siftings Herald 
	 staff reporter. 
	 >> Type the staff member's email address under Work email address. When you use 
	 this field, the writer's name will be hyperlinked to their email address when it displays on 
	 an article.

     
	 ADD A SMART BYLINE TO YOUR STORY 
	 >> Follow the instrucitons above to add a staff member to the directory. 
	 >> Write a story. Look for the Smart Byline check box under the byline field. 
	 >> Check the box to use a smart byline.  
	 >> A dropdown menu will appear. Choose the byline you would like to use. 
	 >>  Press Add. If you make any changes, press Update.  
	 >> Save your story.

 

VII
SAXOTECH ONLINE
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STAFF BLOGS 

CREATING A BLOG POST 
To create a blog post, choose New Story from your homepage. On the Properties tab, 
change the Category to Blogs.  The Category dropdown menu is on the right hand side of 
the page. 

 
On the Properies tab, choose the basic publication settings for your blog post, just as you 
would for a story. You will need to make choices from the fields listed below. Only Published 
and Category are required: 

Published: Check this box when you want the blog post to be published. The blog post will 
publish once you press Save (top right corner). Uncheck this box if you want to remove 
(unpublish) a blog post, or if you are writing a draft.

Pub. Date:   This field contains the publication date for the blog post. The system will 
suggest today's date. To change the date, click on the calendar icon and select a date. The 
required format is the YYYYMMDD format, for example 20050728 for July 28, 2005.

Retain Date: When you edit a blog post, the date and time is changed to reflect the latest 
saved change. By marking this checkbox, the original publication date and time is kept.

Use publish control: Allows you to control when a blog post will be published. Choose the 
date and time you would like the story to go up in the From dropdown menus 

Category:  In this drop-down menu, choose Blogs so your blog post will appear in the blog 
format on your website.

Priority: Priority is used to determine the sequence (or rank) of stories. Use this feature to 
determine the order of stories in your carousel, for example. If you want the story to stay in 
the first position, it should have a priority of 1. 

REQUIRED 
FIELDS
*

*

*
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STAFF BLOGS, CONTINUED 

WRITING A BLOG POST 
To write a blog post, go to the Edit tab. 

 
On the Edit tab,fill out all of the text fields as you would for a story: Title, Summary,  Story 
Body.

Smart Byline does not currently work for staff blogs.

ADDING PHOTOS

Add a Main Photo just as you would for a story, using the Main Photo tool on the right side 
of the page. 

You can insert additional photos within the body of the blog post. Put your cursor in the 
Story Body text box where you want the photo to appear. Click on the photo icon to the left 
of the Story Body text box. The photo will appear as a thumbnail under the photo icon. You 
will not see it in the Story Body text box, but it will appear in the body of your blog post on 
your website.
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STAFF BLOGS, CONTINUED 

CHOOSING TAXONOMIES 
Choose your blog under Staff in the Blog taxonomy.

Make sure you choose your publication in the Publication taxonomy.

PUBLISHING YOUR BLOG POST

On the Properities tab, click on the box next to Publish. Click on Save in the upper right 
corner of the page.
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ADDING A TWITTER WIDGET TO AN ARTICLE 

CREATE A TWITTER WIDGET 
>> Go to https://twitter.com/settings/widgets and log in with your Twitter 
account.

>> Press Create New in the top right side 
of the page

>> Your widget options will display here. 
Choose User (to pull in all tweets from 
a username), Favorites (to pull in all 
widgets from your favorited tweets), List 
(to pull in all tweets from a Twitter list), or 
Search to query a hashtag.

>> Configure your widget using the 
options provided to you. In general, you 
want to choose "Safe search mode" 
when using hashtag search. Keep the 
theme set to light.

>> When your settings are complete, 
press "Create Widget." You will be given 
some HTML code in a box at the bottom 
right of the screen. Save that piece of code.

ADD A TWITTER WIDGET TO AN ARTICLE

>> In EditUI, find the article you would like to add the widget to. Open the 
story to the Edit tab.

>> At the bottom of the article page, you 
will find a field called "Twitter widget." 
Copy and paste the entire bit of HTML 
code that was provided to you from 
Twitter. If you want to use the same 
widget multiple times, you do not have 
to create it new every time. Just save the 
original piece of HTML provided to you 
from Twitter.

>> Press Save. The widget will appear 
on your article in the left rail.
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PUBLISHING AN ARTICLE  
 

You will be able to publish any article you create in MediaWare Center to your website.

CREATE A NEW STORY 
	 >> Create an article in MediaWare Center. 
	 >> Write your headline, byline (on one line), and body paragraphs.  
	 >> Attach photos to your article. The top photo that is linked to the article is the photo 
	 that will appear as your main image. All other photos will appear as secondary images. 
	 To rearrange the photos on your article, just drag and drop the photos into the correct 
	 order.

ADD PROPERTIES ON YOUR ARTICLE 
	 >> Open the properties panel of your article. To do this, either right click on the article 
	 and choose Edit Properties, or select the article and click on the Properties button. 
	 >> On the General tab, make sure to choose your correct channel from the list. Your 
	 channel is your state, followed by your city. 
	 >> Select the Web tab. Fill out the following fields: Taxonomies and online publication 
	 time. 
 
ADD TAXONOMY TO YOUR ARTICLE  
Taxonomy is how you will control where your story will be published on your website. 
You can think of taxonomy words as topic tags that organize your content.  To choose a 
taxonomy for an article ...

	 >> Underneath the taxonomies box, choose the button that says Add. 
	 >> A taxonomies window will appear. Underneath the browse area, you will 
	 need to choose from three menus: Placement, Publications and Topic.  
	 >> Press the Arrow next to each area to choose your taxonomies. 

	 Placement: Check the area on your site you would like the article to appear: 
	 Blog network, Breaking News, Carousel, Features, News Now, Photo 
	 Galleries, Promotions, Special Sections, Top Stories, Mobile, Video, 
	 Web Extras, Your Photos. (See About Placement on the next page)

	 Publications: Check the website you would like to publish to.

	 Topic: Under this category, choose the most specific taxonomy topic you 
	 can. For instance, if you have a high school football story, make sure to  
	 check High School Football instead of Sports. Sports  and High School  
	 Sports will automatically be checked since they are higher taxonomies.

	 >> After you choose each taxonomy, press Add. 
	 >> After all the taxonomies are chosen, press OK.

	

ADD PUBLICATION TIME TO YOUR ARTICLE  
	 >> On the Web tab, find where it says Online publication time. Choose either 
	 Immediately or use publication. 
	 >> If you choose Use publication, you must choose a date and time from the 
	 dropdown menus next to the word Earliest. Unless you want your story to be 
	 unpublished at a certain time, leave the word Undated in the Latest field. 
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PUBLISHING AN ARTICLE (CONT'D) 
 

PUBLISH YOUR ARTICLE  
After your publication details have been chosen, close the properties box by pressing OK. 
	 >> Select your article. press the Update button in the toolbar. 
	 >> To publish your story, you can either press the Publish button in the toolbar or right  
	 click the article and choose Publish on channel. Choose your site from the list.  
	 >> To unpublish, right click on an article and choose unpublish. 

ADD RELATED CONTENT  
You can add other items from the MediaWare Center to your article and publish them as 
related content. 
	 >> Select your article. From the work menu, select Add online... and then Online links. 
	 >>  Use the dropdowns to find the content you are searching for. You can search by  
	 Channel (publication), days, taxonomy, category and more. Videos, blogs and Local  
	 Loop are listed under CCE. Press Search. 
	 >>Once you find the content, press Add.  
	 >> If you have already published your article, press Publish again. 
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PUBLISHING A GALLERY  
 

CREATE A NEW GALLERY 
	 To create a gallery inside of a story package: 
	 >> Open the properties window of your story package. Select Photo gallery under 
	 Create new and link. 

	 ADD PROPERTIES TO A GALLERY 
The properties panel is where you will add the headline, summary and publication details 
for  your photo gallery. 
	 >> To open the properties menu for a gallery, right click on the gallery and select 
	 Properties or select the element and choose Properties from the toolbar. 
	 >> Write the headline for the gallery in the Name field. 
	 >> Write the summary for the gallery in the Summary field.  
	 >> Choose the correct channel (website) from the channel dropdown.  

After you have completed the General tab in the gallery properties panel, you will need to 
click on the tab that says Web 
	 >> Underneath the taxonomies box, choose the button that says Add. 
	 >> A taxonomies window will appear. Underneath the browse area, you will 
	 need to choose from three menus: Placement, Publications and Topic.  
	 >> Press the Arrow next to each area to choose your taxonomies. 

			   Placement: Check Photo Galleries

			   Publications: Check the website you would like to publish to.

			   Topic: Check the most specific topics for your gallery. 

	 >> After you choose taxonomies from each section, press Add. 
	 >> After all the taxonomies are chosen, press OK. 

PHOTO 
GALLERY 
ICON >>
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PUBLISHING A GALLERY (CONT'D) 
 

ADD PUBLICATION TIME TO YOUR GALLERY  
	 >> In the properties window Web tab, find where it says Online publication time. 
	 Choose either Immediately or use publication. 
	 >> If you choose Use publication, you must choose a date and time from the 
	 dropdown menus next to the word Earliest. Unless you want your story to be 
	 unpublished at a certain time, leave the word Undated in the Latest field.  
	 >> After all your properties have been chosen, choose Apply. 
 
ADD PHOTOS TO A GALLERY 
You will need to upload the photos into the MediaWare Center before you add them to a 
gallery. You can upload them to a photo request or story package using the Link to Request 
method, and you can also upload using the category method. Please visit the chapter on 
photos for more instructions. 
 
Once your photos are in the system, you can link them to the photo gallery element 
via the drag and drop method.  
	  
	 >> Hold down the Control key and select the photo you would like to add to a gallery. 
	 Continue to hold down the control key, and drag the photo to the gallery.  
	 >> Drop the photo directly on top of the gallery icon. You know it has been added 
	 when a grey triangle appears next to the gallery icon. 
	 >> If the photo already has a caption, that caption will remain with the photo. To change 
	 or add a caption, double click on the caption element. Write your caption in the Caption 
	 text area and press OK. 
	 >> To rearrange the order of photos that are attached to a gallery, drag and drop to the 
	 order you would like the photos to appear in.  

PUBLISH YOUR GALLERY  
After your publication details have been chosen, close the properties box by pressing  OK.  
	 >> Select your photo gallery. 
	 >> Press the Publish button in the toolbar or right click the article and choose Publish  .  
	 on channel. Choose your site from the list.  
	 >> To unpublish, right click on an gallery and choose unpublish.  

 
For instructions on polls, videos, maps and adding files, see  
chapter VII: Saxotech online.*
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ADD AN ONLINE ICON TO YOUR WORKBENCH
 >> Find the sunburst on the view you want to change (article, gallery, etc.)

	 >> Click the sunburst. Go to List View > Edit

	 >> When the window opens, find 'related article element' in the list on the left side.

	 >> Drag it over to the list on the right side

	 >> You can drag and drop items in this list to change the order they appear in your 
workbench.

	 >> Press "OK"

	 You wiill need to restart MWC to see your changes.

 

         HOW TO SUBMIT CONTENT TO GHNS/MORE 
CONTENT NOW
There are two ways to submit national-interest content to GateHouse News Service/More 
Content Now in Saxotech. This replaces the method your paper used in Zope with the 
“Submit National Content” button.

1. When creating a story package, there is a button that says “To GHNS.” This will mark 
it to our attention. If a story package is already created, highlight the package and click 
“Properties” — you can check “To GHNS” then, too. 

** NOTE: Please do not use this button for all your content; only mark national-interest 
content with this. This is separate from Design House and will not affect any work you do with 
them. 

2. Right click on the article you wish to submit. Go to “Create copy on channel” and then 
select GHNS. This will create a copy in our GHNS queue. Edits made to the master file (your 
story) will not be reflected in the copy, and vice versa, similar to how it worked in Zope. If 
there are important changes or updates to the original article, please email Lisa Glowinski 
(lglowinski@gatehousemedia.com) and Michael Toeset (mtoeset@gatehousemedia.com). 


